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Введение

TEX (читается «тех») — система для набора и вёрстки текстов с фор-
мулами. С её помощью можно подготовить к печати и небольшую ста-
тью, и солидную монографию (причем не только по физико-математи-
ческим наукам).

TEX
тау

эпсилон

хи Слово TEX — набор заглавных греческих букв: тау,
эпсилон и хи, являющихся корнем слова «техника»,
изначальное значение которого «искусство».

Сам по себе TEX — это специализированный язык программирова-
ния для создания издательских систем. Создатель TEX’а Дональд Кнут
начал его разработку в 1977 г. Издательская система LATEX, в основе ко-
торой лежит TEX, была создана Лесли Лэмпортом в 80-х гг. Современная
версия — LATEX 2ε — появилась в 90-х гг. (авторы: Франк Миттельбах,
Крис Роули и Райнер Шопф).

В тексте, предназначенном для LATEX 2ε, можно использовать многие
команды TEX’а и LATEX’а, поэтому слова TEX, LATEX, LATEX 2ε далее будут
использоваться как синонимы.

Недостаток TEX’а (с точки зрения начинающего TEXника):
• нельзя мгновенно увидеть результатов свой работы (т. е. система не
работает по принципу WYSIWYG — What You See Is What You Get).
От пользователя требуются дополнительные действия, чтобы получить
набранный текст в том виде, в котором он может быть распечатан на
принтере или прочитан с экрана дисплея.

Достоинства TEX’а : • позволяет создавать тексты высокого по-
лиграфического качества; • нетребователен к технике и программному
обеспечению (исходные тексты можно готовить в любом текстовом ре-
дакторе); • не зависит ни от архитектуры компьютера, ни от операцион-
ной системы — текст будет одинаково обработан на любом компьютере;

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 5
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• может применяться пользователями даже с низким уровнем квали-
фикации; • позволяет пользователю сосредоточиться на самом тексте,
возложив на TEX заботы об оформлении текстового документа в целом;
• обеспечивает высокое качество вёрстки текста, математических и хи-
мических формул; • допускает набор формул любой степени сложности;
• автоматически нумерует разделы текстового документа, уравнения и
т. п.; • позволяет организовать автоматические ссылки; • имеет удобные
средства генерации алфавитного указателя, списков литературы, рисун-
ков и таблиц; • содержит развитые средства импортирования в доку-
мент графики; • позволяет преобразовывать исходные файлы в форма-
ты PostScript, PDF, HTML; • распространяется бесплатно.

Дистрибутив TEX’а для платформы Windows — MiKTeX — содержит
полный набор макропакетов: LATEX 2ε, AMS-TEX и др., а также сред-
ство просмотра dvi-файлов Yap (Yet Another Previewer), дополнитель-
ные инструменты и утилиты. MiKTEX находится в свободном доступе
в Интернете по адресу: miktex.org.

Текст документа готовится в любом текстовом редакторе, позволяю-
щем создавать обычные текстовые файлы. Специализированные редак-
торы-оболочки для работы с документами TEX’а:

• коммерческий редактор WinEdt (www.winedt.com);

• бесплатный редактор TEXnicCenter (www.texniccenter.org).

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 6
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Условные обозначения

WinEdt — советы по работе в редакторе WinEdt (см. c. 13).

3. Набор текста — гипертекстовая ссылка на раздел учебника.

[2] — гипертекстовая ссылка на библиографический источник.

— начало примера (см. пример на c. 39).

— начало упражнения (см. упражнение на c. 13).

Текст для набора и верстки в упражнениях. Например, см. c. 14.

Исходный код: (например, см. c. 13)

TEX-код
\documentclass{article}
\begin{document}
\end{document}

— замечание (например, см. замечание на c. 29).

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 7
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План занятий

Модуль I

1. Знакомство с LATEX 2ε

Лекции (2 ч.) + практика (1 ч.)

1. ПО для работы с TEX’ом: классификация, установка, настройка.

2. Классы документа.

3. Использование дополнительных пакетов.

4. Основные понятия TEX’а.

5. TEX’овские единицы длины.

6. Титульная страница: определение, основные составляющие, созда-
ния титула в TEX’е с помощью специальных команд.

2. Макет полосы набора; проекты

Лекции (1 ч.) + практика (2 ч.) + индивидуальный проект (1 ч.)

1. Макет полосы набора: параметры страницы, стиль оформления
страниц, интерлиньяж, абзацный отступ.

2. Создание проектов.

3. Набор текста

Лекции (1 ч.) + практика (2 ч.)

1. Атрибуты шрифтов.

2. Буквальное воспроизведение.

3. Кавычки, многоточие, тире и дефисы.

4. Вертикальные и горизонтальные пробелы: тонкая настройка.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 8
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4. Верстка текста, автоматическая генерация ссылок

Лекции (2 ч.) + практика (2 ч.) + индивидуальный проект (2 ч.)

1. Разрывы страниц. Создание пустых страниц.

2. Структура текстового документа.

3. Титульная страница: создание оригинальной титульной страницы.

4. Создание аннотаций.

5. Команды секционирования. Правила оформления заголовков.

6. Оглавление. Организация автоматических ссылок на разделы доку-
мента.

7. Создание списков литературы. Организация автоматических ссы-
лок на литературные источники.

8. Абзацы с нестандартным форматированием.

9. Создание таблиц.

10. Создание и использование шаблонов текстовых документов.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 9
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Модуль II

5. Набор простых формул

Лекции (2 ч.) + практика (2 ч.)

1. Правила набора формул (внутритекстовые и выключные формулы,
знаки препинания в формулах).

2. Математические шрифты.

3. Размер символов в формулах.

4. Разные символы и знаки, греческие буквы.

5. Символы бинарных операций и отношений, стрелки, степени и ин-
дексы, дроби, корни, штрихи.

6. Набор формул — почти “высший пилотаж”

Лекции (2 ч.) + практика (2 ч.)

1. Скобки и ограничители, команды \left и \right.

2. Названия операций, операции с пределами.

3. Создание собственных операций.

4. Пробелы в формулах.

5. Текст в формулах.

6. Надстрочные знаки.

7. Нумеруемые однострочные формулы.

8. Многострочные формулы — окружение array.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 10
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Модуль III

7. Вставка изображений

Лекции (1 ч.) + практика (2 ч.)

1. Универсальная команда \includegraphics.

2. Масштабирование и поворот рисунка.

3. Окружение figure.

4. Создание списка иллюстраций.

5. Создание министраниц.

8. Программа TpX

Лекции (1 ч.) + практика (2 ч.)

1. Специализированное графическое ПО для создания рисунков для
TEX’а.

2. Специфика создания рисунков для публикации.

3. Работа с векторным редактором TpX.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 11
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Модуль IV

9. Цвет и визуальные эффекты

Лекции (2 ч.) + практика (2 ч.)

1. Цветовые модели RGB, CMYK, grayscale. Первичные и вторичные
цвета. Цветовой куб.

2. Цвет фона страницы и цвет текста.

3. Цветные боксы.

4. Рамки с тенью.

5. Списки в рамке.

10. Электронные документы в формате PDF

Лекции (2 ч.) + практика (2 ч.) + индивидуальный проект (2 ч.)

1. Пакет hyperref.

2. Принципы создания электронных учебников, пособий и т. п.

11. Создание презентаций

Лекции (2 ч.) + практика (2 ч.) + индивидуальный проект (2 ч.)

1. Класс beamer.

2. Основы создания электронных презентаций.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 12



1 Знакомство с LATEX 2ε
1.1 Начало работы
1.2 Поддержка русского языка
1.3 Учимся разбираться с ошибками
1.4 Некоторые важные правила набора текстов
1.5 Титульный лист
1.6 Тесты

Перейти в раздел 2 раздел 3 раздел 4

1 Знакомство с LATEX 2ε

1.1 Начало работы

WinEdt Трансляция tex-кода — кнопка LaTeX (Shift+Ctrl+L) на па-
нели инструментов.

WinEdt Просмотр dvi-файла с помощью программы Yap — кнопка
DVI Preview (Shift+Ctrl+V). Для того чтобы из окна просмотрщика
Yap вернуться в WinEdt не надо закрывать окно Yap, просто миними-
зируйте его.

1.1 (создание первого документа). а) В текстовом редакторе создай-
те новый файл. Сохраните его под каким-либо именем (желательно не
содержащим русских букв и пробелов), тип файла — TEX (расширение
tex, по умолчанию в WinEdt).

б) Наберите (или скопируйте из pdf-файла) строки:
TEX-код

\documentclass{article}
\begin{document}
\end{document}
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Это минимальный tex-файл с заголовком

\documentclass{article}

и командными скобками \begin{document} и \end{document}, являющи-
мися началом и концом окружения document.

в) Между командами \begin{document} и \end{document} наберите
текст (тело документа):

Rostov-on-Don 2009 Ростов-на-Дону

г) Странслируйте созданный документ в TEX’е. При отсутствии оши-
бок TEX должен создать новый файл с расширением dvi.

д) Просмотрите полученный dvi-файл с помощью программы Yap:
должен отобразиться весь текст, кроме русских букв.

1.2 Поддержка русского языка

Между командами

\documentclass{article} и \begin{document}

находится преамбула документа, в которой могут быть размещены описа-
ния, расширяющие базовую версию используемого класса (article в на-
шем случае; файлы классов имеют расширение cls).

В преамбуле могут содержаться команды \usepackage для подклю-
чения пакетов (файлы с расширением sty), модифицирующих базовую
версию класса.

1.2 (поддержка русского языка). а) Добавьте в преамбулу документа
строки, реализующие поддержку русского языка:

TEX-код

\usepackage[cp1251]{inputenc}

\usepackage[russian]{babel}

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 14
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б) В тело текста добавьте строку:

Изучаем систему LATEX 2ε для набора математических текстов.

в) Странслируйте измененный документ и просмотрите полученный
dvi-файл. Обратите внимание на вид логотипа LATEX2ε и на наличие
пробела после него.

WinEdt Трансляция исходного файла с последующим вызовом
программы Yap — кнопка TeXify (Shift+Ctrl+X).

1.3 Учимся разбираться с ошибками

Сведения об обработке текста (протокол трансляции) TEX выдает на
экран и записывает в log-файл.

WinEdt Открыть log-файл — Search → Errors. . .

Часть информации, содержащейся в протоколе, представляет собой
предупреждения, при выдаче которых трансляция не прерывается (на-
пример, о невозможности автоматического переноса некоторого слова).
В случае, однако, если TEX находит в исходном тексте синтаксическую
ошибку обработка файла приостанавливается, а на экран выдается со-
общение об ошибке.

1.3 (исправление ошибок). а) Внесите в набранный текст

Изучаем систему LATEX 2ε для набора математических текстов.

ошибки:

1) слово «систему» начните со знака «\»;

2) команду для генерации логотипа LATEX 2ε замените на \LaTeX;

3) перед точкой поставьте пробел.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 15
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б) Перетранслируйте измененный документ.
Успешной трансляции не получится, так как первая ошибка является

грубейшей в TEX’е — знак «\» является признаком команды, а ни одна
команда не начинается с русской буквы.

Сообщение об ошибке будет иметь вид (русский текст может на экране
не отображаться):

Сообщение об ошибке
! Undefined control sequence
l.7 Изучаем \с

истему {\LaTeX} для набора математических
?

В сообщении указывается тип ошибки
Сообщение о типе ошибки

! Undefined control sequence

(несуществующая команда) и номер строки с ошибкой (7 — в нашем
tex-файле). Чтобы аккуратно закрыть экран с сообщением об ошибке
введите букву x — обработка файла прервется.

Исправьте ошибку и заново странслируйте текст.

Ошибок больше не будет, хотя текст оказался изрядно подпорчен:

• вместо логотипа LATEX 2ε появится другой — LATEX;

• пробел перед точкой — это грубейшая ошибка набора, но компиля-
тор ее не в силах исправить.

Изучаем систему LATEX для набора математических текстов .

TEX не может исправить все Ваши ошибки набора

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 16
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1.4 Некоторые важные правила набора текстов

Запомните следующие правила набора текстов, которые не имеют
никакого отношения к TEX’у, но связаны с общей культурой набора.

Правило 1. После любого знака препинания ставится пробел, сам
знак препинания никогда не отрывается от предыдущего слова

медведи,␣лисы.

Правило 2. При расстановке скобок (кавычек) открывающая скоб-
ка набирается с отбивкой (пробелом) от предыдущего слова и без
отбивки от последующего; закрывающая — наоборот

Зверь␣(заяц)␣страшный.

Правило 3. Пробелы обязательны:
— между цифрой и сокращением (в том числе между цифрой и обо-
значением физической величины): 1␣кг, 2002␣г.

— между номером (буквой, символом) и следующим словом в пе-
речне: а)␣красный,␣б)␣синий,␣в)␣желтый.

— между знаком параграфа (номера) и следующей за ним цифрой:
§␣3, №␣115.

— между инициалами и между инициалом и фамилией:
Иванова␣И.␣И.

— в cокращениях от чисел и слов, к ним относящихся: тыс.␣руб.

— между частями составного сокращения: т.␣д., т.␣п.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 17
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1.4 (почти простой текст). Добавьте новый абзац в свой tex-документ:

Иванов И.И. (студент Института математики, механики и
компьютерных наук Южного федерального университета). Но-
мер студенческого билета: № 305800. Хочу зарабатывать ежегодно
1 млн. руб. (а может и 1 млн. $).

1.5 (текст с командами). Добавьте новый абзац в свой tex-документ:

В 2014 г. исполнилось 30 лет со дня создания системы LATEX и
20 лет со дня создания LATEX 2ε. Для представления формул в Вики-
педии (универсальной энциклопедии) используется TEX-нотация.

WinEdt Страница Typeface панели GUI WinEdt содержит команды
для изменения начертания шрифта. (см. рис. 1).

Рис. 1. Страница Typeface панели GUI WinEdt

1.6 (текст с форматированием). Добавьте новый текст в свой tex-
документ. Обратите внимание на отсутствие абзацных отступов.

Stein D. The website as a domain-specific genre // Language@internet.
2006. № 3.
URL: http://www.languageatinternet.de/articles/2006/374/index_html.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 18
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1.5 Титульный лист

Титульный лист, как таковой, может быть создан только в определен-
ных классах, например, book. В стиле article титульный лист по умолча-
нию не создается, обычно в этом стиле создается «шапка» статьи с вы-
ходными данными. Далее будем говорить о создании заголовка тексто-
вого документа, не делая различия между «шапкой» и титулом.

Чтобы TEX «сам» смог создать заголовок необходимо сначала задать
для него информацию, которая обычно состоит из сведений об авторе,
названия работы и некоторой служебной информации (например, наиме-
нование учреждения, где выполнена работа).

Автор и заглавие работы задаются, соответственно, командами

\author{имя автора} \title{заглавие}

Длинное заглавие будет автоматически разбито на строки, хотя это
удобнее сделать вручную с помощью команды «\\» (разорвать строку).

Команда
\date{текст}

позволяет задать любой текст, который будет размещен на титульном листе.
Команда \date не является обязательной, однако, если ее не указать, то
в выходном файле будет выводиться дата трансляции файла. Поэтому, в
случае отсутствия информации, задаваемой командой \date, она должна
быть дана с пустым аргументом: \date{}.

Команды \author, \title, \date могут даваться в любом порядке,
но стоять они должны обязательно до вызова \maketitle (обычно в пре-
амбуле документа).

К любой из команд для создания заголовка можно сделать сноску
с помощью команды

\thanks{текст сноски

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 19
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Она используется внутри команд \author, \title, \date и генерирует
текст сноски1, который будет напечатан внизу первой страницы доку-
мента. Например,

\title{Методические указания\thanks{Краткий вариант.}}

Генерация заголовка происходит по команде \maketitle, которую
указывают сразу после \begin{document}.

1. Указанный выше способ создания «шапки» часто применяется
в работах, входящих в сборники научных статей.

1.7 (создание «шапки» документа). Создайте с помощью команды
\maketitle заголовок к Вашему текстовому документу в виде

Лабораторная работа № 1a

И.И. Иванов

Южный федеральный университет

a Первый опыт.

1.8 (эксперимент с классами документа). Измените класс докумен-
та с article на book. Странслируйте документ и посмотрите результат
изменения класса.

1 Текст сноски всегда оканчивается знаком препинания, как правило, точкой.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 20
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1.6 Тесты

Раздел А «Выбор правильного ответа»

А1. Исходный файл для LATEX’а по традиции имеет расширение:

а) dvi б) cls в) tex г) log

А2. Файл LATEX’а для просмотра и вывода результата работы на печать
имеет расширение:

а) aux б) log в) dvi г) tex

А3. Протокол трансляции содержится в файле с расширением:

а) dvi б) aux в) sty г) log

А4. Программа Yap предназначена

а) для просмотра протоколов трансляции

б) для набора и редактирования исходного текста для LATEX’а

в) для просмотра и вывода на печать результата работы LATEX’а

г) для трансляции исходных файлов LATEX’а

А5. Выберите верно оформленный список:

1) а)Заяц (зверь); б)Кактус (растение); в)Студент (человек)

2) а) Заяц (зверь) ; б) Кактус (растение) ; в) Студент (человек)

3) а) Заяц (зверь); б) Кактус (растение); в) Студент (человек)

4) а) Заяц ( зверь ); б) Кактус ( растение ); в) Студент ( человек )

А6. Заголовок исходного файла для LATEX’а имеет вид (класс article):

а) \documentclass[article]

б) \documentclass{article}

в) \documentclass[article]{}

г) \documentclass{article,12pt}

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 21
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А7. Файл *.sty — это файл, содержащий:

а) набор команд, не специфичных для данного класса или изменя-
ющий настройки класса по умолчанию

б) список литературы

в) набор настроек системы LATEX

г) основной текст документа

А8. Дополнительные пакеты в файле LATEX’а подключаются с помощью
команды:

а) \newpackage б) \newcommand в) \pagestyle г) \usepackage

А9. Спецсимволами в LATEX’е считаются символы:

а) цифры + символы \ { } % ~ # $ & _ ^

б) символы ∞, ∇, c©, ∃, ∀
в) все буквы латинского и русского алфавитов + цифры

г) символы \ { } % ~ # $ & _ ^

А10. Группа — это фрагмент файла, ограниченный

а) любыми скобками

б) фигурными скобками

в) командами \begin{} \end{}

г) символами \

А11. Кегль выражается

а) в пунктах

б) в миллиметрах

в) в дюймах

г) в километрах

А12. Пункт в системе TEX равен:

а) 0,35 см б) 0,376 см в) 0,35 мм г) 0,376 мм

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 22
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А13. Относительные единицы длины так называются, потому что вели-
чина, задаваемая с их помощью

а) не зависит от размера используемого шрифта

б) зависит от размера используемого шрифта

в) определяется отношением 1/72 pt

г) определяется отношением числа строк в странице к числу симво-
лов в строке

Раздел B «Короткий ответ»

B1. Создайте минимальный файл LATEX’а для вывода логотипа LATEX 2ε.

B2. Укажите общий формат команд LATEX’а с параметрами.

B3. Дайте определение кегля.

B4. Перечислите относительные единицы длины в системе TEX.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 23
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Открыть тест с возможностью самопроверки

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 24



2 Макет полосы набора; проекты
2.1 Параметры страницы
2.2 Проекты
2.3 Тесты
2.4 Индивидуальные проекты

Перейти в раздел 1 раздел 3 раздел 4

2 Макет полосы набора; проекты

2.1 Параметры страницы

Стандартный лист формата A4 имеет размеры: 210×297 мм. Опция
класса a4paper облегчает подгонку текста под лист формата A4.

Верхний колонтитул

Нижний колонтитул

Тело текста

1

2

3

4
5

6

11

9

10

8

7

1 один дюйм + \hoffset

2 один дюйм + \voffset

3 \oddsidemargin

4 \topmargin

5 \headheight

6 \headsep

7 \textheight

8 \textwidth

9 \marginparsep

10 \marginparwidth

11 \footskip

Например, параметр \textwidth = 165mm (указывается в преамбуле
документа) позволит установить ширину текста, равной 165 мм.
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2. Выполнение упражнений 2.2–2.7 из этого пункта позволит удо-
влетворить правилам оформления выпускных, дипломных, диссерта-
ционных и депонированных работ.

Поле слева 3 см
Поле справа не менее 1 см (лучше 1,5 см)
Поля сверху и снизу 2,5 см
Межстрочный интервал: 1.5–2.0
Размер основного шрифта: 14 пт
Нумерация страниц: вверху, посередине

2.1 (копия файла). Создайте в отдельном каталоге копию файла со
всеми ранее набранными текстами. Имя нового файла — DiplomMain.tex

(далее работайте с этим файлом). Удалите из файла DiplomMain.tex все
команды для создания титульной страницы.

2.2 (размеры полей). 1) Для задания требуемых размеров полей уста-
новите соответствующие параметры страницы в файле DiplomMain.tex.
Указание. При выполнении задания используйте только параметры

\oddsidemargin, \topmargin, \textheight, \textwidth.

2) Проверьте созданный макет на соответствие заданию с помощью
команды \layout из пакета layout.

2.3 (межстрочный интервал). Увеличьте в документе интервал между
строками на 30%.

2.4 (размер шрифта). Установите размер шрифта 12 пт (опция в за-
головке tex-файла). Команда \large в начале тела документа позволит
изменить размер шрифта документа на принятый для набора курсовых
и дипломных работ (12 pt + \large ≈ 14 пт).

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 26



Макет полосы набора; проекты 27

2.5 (величина абзацного отступа). Установите в документе величину
абзацного отступа, равной ширине двух букв «М» текущего шрифта.

2.6 (номера страниц). Для всех страниц установите стиль myheadings,
а сразу после команды, начинающей тело Вашего текстового докумен-
та, наберите строки, позволяющие создать номера страниц вверху листа
(этот стиль не предусмотрен стандартными пакетами, но предусмотрен
требованиями, предъявляемыми к оформлению выпускных работ):

TEX-код
\documentclass[...]{...}
...
\pagestyle{myheadings}

\begin{document}

%-------- № страницы вверху, посередине --------
\makeatletter
\renewcommand{\@oddhead}{\hfil\thepage\hfil}
\makeatother

%-----------------------------------------------

...
\end{document}

2.7 (первая страница без номера страницы). Установите стиль для
первой страницы, исключающий номер и колонтитул страницы.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 27
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2.2 Проекты

Тексты большого размера удобно разбивать на несколько частей, хра-
нящихся в разных файлах. В LATEX’е предусмотрены команды \include

и \input, при которых транслятор будет автоматически склеивать со-
держимое файлов, указанных в качестве аргумента.

Обычно создается один «главный» файл, содержащий основные ко-
манды обработки текста в преамбуле и последовательность команд для
подключения файлов-частей в качестве тела документа. Именно этот
файл должен вызываться для трансляции.

Главный файл, подключающий, например, файлы, содержащие от-
дельные главы, может иметь вид

TEX-код главного файла

\documentclass[12pt]{article}

... % преамбула

\begin{document}

...

\include{ch0} % подключить файл ch0.tex

\include{ch1} % подключить файл ch1.tex

\end{document}

Файл ch0.tex, подключающий параграфы некоторой главы, может
состоять только из нескольких строк, подключающих файлы с текстами
параграфов. Например,

TEX-код файла ch0.tex
\input par1.tex
\input par2.tex

В файлах par1, par2 будет располагаться непосредственно текст ра-
боты (ни заголовка, ни преамбулы в этих файлах быть не должно!).

Такая компоновка удобна при очень объемных текстах. Если потре-
буется изменить порядок следования параграфов, то достаточно будет
лишь поменять местами пару строк, а не огромные фрагменты текста.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 28
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3. Структуру проекта отражает «Project Tree» (дерево проекта) ре-
дактора WinEdt (см. рис. 2).

Рис. 2. Project Tree (слева) в окне WinEdt

WinEdt Показать/убрать дерево проекта

Project → Tree. . .

Команда \include

Формат команды \include:

\include{имя_файла}

При указании в качестве аргумента команды \include имени несуще-
ствующего файла LATEX, не прерывая трансляции, выдаст предупрежде-
ние «Файл ... не найден».

Команда \input

Команда \input имеет следующий вид

\input{имя_файла}

и позволяет подсоединить любой текстовый файл.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 29
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При указании в качестве аргумента команды \input имени несуще-
ствующего файла TEX прервет трансляцию файла, выдаст сообщение об
ошибке и запросит другое имя файла. Например, пусть ошибочно запи-
сали расширение файла \input par2.te:

Сообщение об ошибке
! I can’t find file ‘par2.te’.
l.65 \input par2.te
Please type another input file name:

В ответ на это сообщение нужно ввести либо правильное имя файла,
либо слово nul.

2.8 (создание проекта). а) Создайте новый tex-файл с именем Part01

(с помощью команды File → New). Наберите в нем текст

\section{Первая глава}

Первая часть большого документа.

В файле Part01.tex должен содержаться только этот текст и никаких
команд типа \begin{document}.

б) Создайте новый tex-файл с именем Part02. Наберите в нем текст

\section{Вторая глава}

Вторая часть большого документа.

в) Откройте файл DiplomMain.tex, созданный в упр. 2.1. Этот tex-
документ будет главным файлом. В файле подключите первую и вто-
рую части с помощью команды input. Посмотрите результат трансляции
файла DiplomMain.tex.

Обратите внимание, что TEX перед заголовком первой части поста-
вил номер 1. Использованная команда \section{} позволяет создавать
автоматически нумеруемые разделы.

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 30
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в) В главном файле измените порядок вызовов частей и заново его
транслируйте. Посмотрите результат в dvi-файле.

TEX автоматически перенумерует разделы Вашего текстового доку-
мента.

WinEdt Назначение текущего файла главным — команда

Project → Set Main File

Обратное действие — команда

Project → Remove Main File

Указанным командам соответствуют кнопки с зеленым плюсом и
с красным минусом на панели инструментов

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 31
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2.3 Тесты

Раздел А «Выбор правильного ответа»

A1. Высота тела документа задается с помощью параметра:

а) \headheight б) \textheight в) \paperheight г) \paperwidth

A2. Для изменения расстояния от левого края бумаги до тела текста
используется параметр:

а) \oddsidemargin б) \footskip

в) \marginparwidth г) \paperwidth

A3. Команда \renewcommand{\baselinestretch}{1.2} изменяет интер-
вал между строками следующим образом:

а) увеличивает на 2% б) увеличивает на 20%

в) увеличивает на 1.2% г) уменьшает на 20%

A4. Какое значение параметра команды \pagestyle{параметр} позво-
лит убрать номера страниц:

а) empty б) plain в) headings г) null

A5. Выберите неверную фразу:

а) абзацный отступ — пробел в начале первой строки абзаца

б) величина абзацного отступа во всем документе может быть изме-
нена в преамбуле документа

г) величина абзацного отступа во всем документе не может быть
изменена в преамбуле документа

д) величина абзацного отступа во всем документе определяется
в файле класса документа
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Раздел B «Короткий ответ»

B1. Имеется лист бумаги формата A4.Ширина тела текста задается рав-
ной 165 мм. Укажите способ задания правого поля, равным 15 мм.

B2. С помощью команды \layout получен макет некоторого документа
(см. рисунок). Чему равны значения параметров \oddsidemargin и
\topmargin?

B3. С помощью команды \layout получен макет некоторого документа
(см. рисунок). Чему равен отступ слева от тела текста документа
в миллиметрах?

Е. В. Ширяева, И. В. Ширяева. Введение в TEX. Часть I 33



Макет полосы набора; проекты 34

ЮФУ, факультет математики, механики и компьютерных наук
Кафедра вычислительной математики и математической физики

Тест для самопроверки
Тема «Макет полосы набора»

Раздел А «Выбор правильного ответа»

2.1. Высота тела документа задается с помощью параметра:

а) \headheight б) \textheight в) \paperheight г) \bodyheight

2.2. Для изменения расстояния от левого края бумаги до тела текста
используется параметр:

а) \oddsidemargin б) \footskip в) \marginwidth г) \paperwidth

2.3. Команда \renewcommand{\baselinestretch}{1.2} увеличивает ин-
тервал между

а) строками на 2% б) строками на 20 %

в) абзацами на 2 % г) абзацами на 20 %

2.4. Какое значение параметра команды \pagestyle{параметр} позволит
убрать номера страниц:

а) empty б) plain в) headings г) null

2.5. Выберите неверную фразу: величина абзацного отступа

а) это величина пробела в начале первой строки абзаца

б) во всем документе может быть изменена в преамбуле документа

в) во всем документе не может быть изменена в преамбуле документа

г) во всем документе определяется в файле класса документа

Закрыть тест (для программы Adobe Reader)

Тест к электронному учебнику: Е. В. Ширяева, И. В. Ширяева.
Введение в TEX. Часть I. Ростов-на-Дону, 2014.

Открыть тест с возможностью самопроверки
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2.4 Индивидуальные проекты

1. Создайте файл DiplomMain.tex проекта «Дипломная работа», под-
ключающий файлы с введением (Intro) и двумя главами (Chapter1,
Chapter2). В файлах Chapter1.tex, Chapter2.tex содержатся ко-
манды подключения файлов parN.tex с текстами разделов. Содер-
жание глав и разделов произвольное (один–два абзаца текста). За-
головки глав и разделов формировать с помощью команд

\chapter{Заголовок главы}

\section{Заголовок раздела}

Структура проекта «Дипломная работа»:

DiplomMain.tex

\documentclass{report}

\begin{document}

подключение файла с введением

подключение файла с I главой

подключение файла со II главой

\end{document}

Intro.tex

Текст введения.

Chapter1.tex

подключение файлов
par1.tex, par2.tex
с разделами 1 и 2

Chapter2.tex

подключение файлов
par3.tex – par5.tex
с разделами 3–5
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2. Создайте файл LectureMain.tex проекта «Курс лекций», подклю-
чающий файлы с двумя лекциями (Lectures1.tex, Lectures2.tex).
В файлах Lectures1.tex, Lectures2.tex содержатся команды под-
ключения файлов TopicN.tex с текстами разделов лекций. Содер-
жание лекций и разделов произвольное (один–два абзаца текста).
Заголовки лекций и разделов формировать с помощью команд

\chapter{Заголовок лекции}

\section{Заголовок раздела}

Курс лекций должен иметь титульный лист, генерируемый с помо-
щью команды \maketitle.

Структура проекта «Курс лекций»:

LectureMain.tex

\documentclass{report}

\begin{document}

формирование титульного листа

подключение файла с I лекцией

подключение файла со II лекцией

\end{document}

Lectures1.tex

подключение файлов
Topic1.tex–Topic3.tex
с разделами 1–3

Lectures2.tex

подключение файлов
Topic4.tex, Topic5.tex
с разделами 4–5
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3 Набор текста
3.1 Смена шрифтов
3.2 Буквальное воспроизведение
3.3 Тесты

Перейти в раздел 1 раздел 2 раздел 4

3 Набор текста

3.1 Смена шрифтов

WinEdt См. страницу Typeface на панели GUI WinEdt.

Шрифт, используемый в основном тексте документа, называется ос-
новным. При необходимости выделения какого-либо фрагмента текста
применяются команды переключения шрифтов.

Команды для смены атрибутов шрифта

\rm \textrm{...} прямой светлый шрифт
\sf \textsf{...} рубленый шрифт
\tt \texttt{...} имитация пишущей машинки

\bf \textbf{...} полужирный шрифт
\it \textit{...} курсив
\sl \textsl{...} наклонный шрифт
\sc \textsc{...} капитель

Команды для переключения размера шрифта

\tiny крошечный \large большой
\scriptsize очень маленький \Large очень большой
\footnotesize маленький \LARGE совсем большой
\small мелкий \huge громадный
\normalsize нормальный \Huge грандиозный
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Реальный размер шрифтов, задаваемых этими командами, зависит
от класса документа. Команды переключения размера шрифта лучше
применять в группе, тогда после закрытия группы восстановится основ-
ной размер шрифта документа. Например,

группа другого размера. {\Large группа} другого размера.

Команды, меняющие размер шрифта, изменяют еще и междустрочное
расстояние — увеличивают, если размер шрифта был увеличен, и умень-
шают в противном случае. Поэтому для правильной расстановки между-
строчного интервала группу, в которой было осуществлено переключение
размера, следует заканчивать после пустой строки.

TEX определяет расстояние между строками на заключительном этапе вёрстки абза-
ца, например, когда встречает пустую строку.

После окончания группы размер шрифта и межстрочное расстояние
автоматически восстановятся.

Исходный TEX-код
{\sf\small {\TeX} определяет расстояние между строками на
заключительном этапе вёрстки абзаца, например, когда
встречает пустую строку.

}
После окончания группы размер шрифта и межстрочное
расстояние автоматически восстановятся.
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3.2 Буквальное воспроизведение

Окружение verbatim позволяет выдавать текст в том виде, как он на-
бран в файле, при этом используется шрифт typewriter. Использование
окружения verbatim удобно, если нужно, например, изобразить команду
TEX’а, не выполняя ее; или изобразить спецсимвол TEX’а. Внутри окру-
жения verbatim можно использовать любые символы, за исключением
строки \end{verbatim}.

WinEdt Команда меню: Insert → Environments

3.1. Использование окружения verbatim для оформления текста
программы.

var a_1, a_2: Integer;

begin

ReadLn(a_1, a_2);

Write(a_1 + a_2);

end.

\begin{verbatim}

var a_1, a_2: Integer;

begin

...

\end{verbatim}

При наборе коротких последовательностей в стиле буквального вос-
произведения удобнее использовать команду \verb. Ее формат несколь-
ко специфичен: после слова \verb должен стоять любой символ, потом
текст для воспроизведения, и в конце — вновь символ, стоящий непо-
средственно после \verb. В качестве символов, открывающих и закры-
вающих verb-текст удобно применять либо символ «дюйма» ", либо вер-
тикальную чёрточку |.

WinEdt См. страницу Typeface на панели GUI WinEdt.

3.2. Текст a_1+a_2 буквально воспроизведен.
Исходный TEX-код

Текст \verb|a_1+a_2| буквально воспроизведен.
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3.1 (учебный текст). Скопируйте приведенный ниже текст «Разные
знаки в тексте» в файл, содержащий вторую главу работы DiplomMain

(см. упр. 2.8). Название главы «Разные знаки в тексте». Используя выше-
изложенную теорию, добейтесь максимального совпадения оформления
текста с исходным.
Указания.

1) Заголовки набирайте с помощью команд \section{Заголовок}

и \subsection{Подзаголовок};
2) Для установки абзацного отступа для первого абзаца section под-

ключите пакет indentfirst с помощью команды \usepackage{}.

Внимательно. При копировании текста из pdf-файла отдельные символы
заменяются символами псевдографики (например, длинные и короткие
тире, кавычки, символ параграфа и т. п.). Все такие символы должны
быть заменены соответствующими TEX-командами и символами.

Открыть версию для печати

Начало текста для набора

1 Разные знаки в тексте

1.1 Кавычки, многоточие, тире и дефисы

При типографском наборе используются различные знаки для откры-
вающихся и закрывающихся кавычек. В русских текстах употребляются
кавычки «ёлочки» и

”
лапки“:

«ёлочки» и
”
лапки“ <<ёлочки>> и \glqq лапки\grqq

Следует помнить, что после команд типа \grqq TEX не ставит знака
пробела и его нужно создавать дополнительно.

”
Лапки“ используются в художественных изданиях и в детских книж-

ках. В остальной литературе лучше выглядят «ёлочки».
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Замечание. Недопустимо для изображение кавычек использовать зна-
чок «дюйма» (").

Для получения в тексте многоточия используется команда \dots:
. . . — многоточие \dots~--- многоточие

Многоточие в начале фразы не отрывается от последующего слова,
в конце фразы — от предыдущего.

Длинное тире в тексте используется в качестве тире как такового.
Окружается с обеих сторон пробелами, причем слева неразрывным (~):
Тире — это . . . Тире~--- это \dots

Короткое тире используется для обозначения периода, а также для
разделения цифр в таких случаях, как телефонный номер

5–15, VII–XIX, 63–34–21 5--15, VII--XIX, 63--34--21

Вокруг короткого тире пробелы не ставятся.
Дефис — короткая горизонтальная чёрточка (-). По правилам пункту-

ации дефис применяется только в некоторых случаях, таких как слож-
ные слова (во-первых) и словосочетания (интернет-кафе); сокращения
(физ-ра); перенос слова на другую строку. Дефис ставится вплотную
к буквам.

1.2 Подчеркивание, текст в рамке

Для подчеркивания текста служит команда \underline{текст}. Под-
черкиваемый текст должен умещаться в одной строке.

Команда \fbox{текст} берет однострочный текст в рамку.

Пример. Для выделения текстового фрагмента лучше изменить начер-
тание шрифта, чем использовать подчеркивание.
Подчеркнутый текст
Текст в рамке

\underline{Подчеркнутый текст}

\fbox{Текст в рамке}

Конец текста для набора
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3.3 Тесты

Раздел А «Выбор правильного ответа»

A1. Выберите верное окончание фразы:
Команды, меняющие размер шрифта,. . .

а) не изменяют междустрочное расстояние

б) изменяют междустрочное расстояние

г) действуют только на один символ

д) задаются в преамбуле документа

A2. Для буквального воспроизведения текста используется окружение:

а) text б) mbox в) quote г) verbatim

A3. Выберите верный пример использования команды \verb:

а) \verb{?} б) \verb(?) в) \verb[?] г) \verb$?$

A4. Какой знак должен быть с обеих сторон окружено пробелами:

а) дефис б) короткое тире в) длинное тире г) кавычки

A5. Выберите верный набор горизонтальных пробелов фиксированной
длины:

а) \, \quad \qquad

б) \quad \qquad \␣

в) \quad \qquad ~

г) ␣ \quad \qquad

A6. Какое значение параметра команды \vspace{параметр} позволит
увеличить интервал между абзацами в два раза:

а) 2 б) 2mm в) \baselineskip г) \medskip
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A7. Дан фрагмент текста:

Команда
Команда
Команда . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Выберите верную последовательность команд для создания беско-
нечно растяжимых промежутков, использованных в данном фраг-
менте.

а) \dotfill

\hfill

\hrulefill

б) \hrulefill

\hfill

\dotfill

в) \fill{_}

\fill{ }

\fill{.}

г) \dotfill{\textwith}

\hfill{\textwith}

\hrulefill{\textwith}

A8. Выберите тип кавычек, который обычно используется в научной
русскоязычной литературе:

а)
”
I тип“ б) «II тип» в) "III тип" г) ‘IV тип’

Раздел B «Короткий ответ»

B1. Заполните таблицу соответствующими командами для задания
шрифтов:

шрифт 1

шрифт 2
шрифт 3
шрифт 4
шрифт 5
шрифт 6

шрифт 7
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B2. Упорядочьте команды в порядке уменьшения задаваемого ими раз-
мера символов (надпишите над командами порядковые номера):

\large \scriptsize \footnotesize \small

\huge \normalsize \Large

B3. Исправьте ошибку в приведенном ниже tex-коде:

Найдите одну ошибку набора

{\Huge {\TeX} определяет расстояние между строками

на заключительном этапе вёрстки абзаца, например,

когда встречает пустую строку.}

Раздел C «ПрактикаF»

C1. Создайте минимальный файл LATEX’а для вывода текста:

В 1986 г. Международная организация по стандартизации приня-
ла стандарт ISO-8879, озаглавленный «Standard Generalized Markup Language
(SGML)». SGML — обобщенный метаязык, позволяющий строить системы ло-
гической, структурной разметки любых разновидностей текстов.

HTML (HyperText Markup Language, «язык разметки ги-
пертекста») — самое известное из приложений SGML. Интересно
отметить, что первая версия языка TEX появилась на свет в 1979 г.
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ЮФУ, факультет математики, механики и компьютерных наук
Кафедра вычислительной математики и математической физики

Тест для самопроверки
Тема «Набор текста»

Раздел А «Выбор правильного ответа»

3.1. Выберите верное окончание фразы:
Команды, меняющие размер шрифта,. . .

а) не изменяют междустрочное расстояние

б) изменяют междустрочное расстояние

в) действуют только на один символ

г) задаются в преамбуле документа

3.2. Для буквального воспроизведения текста используется окружение:

а) text б) mbox в) quote г) verbatim

3.3. Выберите верный пример использования команды \verb:

а) \verb{?} б) \verb(?) в) \verb[?] г) \verb$?$

3.4. Какой знак должен быть с обеих сторон окружено пробелами:

а) дефис б) короткое тире в) длинное тире г) кавычки

Закрыть тест (для программы Adobe Reader)

Тест к электронному учебнику: Е. В. Ширяева, И. В. Ширяева.
Введение в TEX. Часть I. Ростов-на-Дону, 2014.

Открыть тест с возможностью самопроверки
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4 Верстка текста
4.1 Абзацы с нестандартным форматированием
4.3 Окружение tabular
4.4 Титульный лист выпускной работы
4.5 Автоматическая генерация ссылок
4.6 Список литературы
4.7 Создание оглавления
4.8 Тесты
4.9 Индивидуальные проекты

Перейти в раздел 1 раздел 2 раздел 3

4 Верстка текста, автоматическая генерация ссылок

4.1 Абзацы с нестандартным форматированием

Для TEX’а стандартным стилем форматирования абзацев является
форматирование «по ширине». Однако иногда возникает необходимость
в нестандартных абзацах — например, с выравниванием текста по пра-
вому краю:

Все строки этого абзаца
будут выключены

вправо.

\begin{flushright}

Все строки этого абзаца будут

выключены вправо.

\end{flushright}

с центрированием текста:

Все строки этого абзаца
будут центрированы

\begin{center}

Все строки этого абзаца будут

центрированы

\end{center}
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Для оформления абзацев с нестандартным форматированием преду-
смотрены специальные окружения:

Стиль абзаца Название окружения

центрирование center

по левому краю flushleft

по правому краю flushright

короткие цитаты quote

длинные цитаты quotation

аннотация abstract

WinEdt Команда меню: Insert → Environments

4.1 (создание аннотации). В самом первом tex-файле (см. упр. 1.1–
1.7) создайте аннотацию для своего текстового документа в виде:

Аннотация должна отражать суть исследуемой проблемы и
полученный результат. Текст аннотации занимает один абзац,
не содержит формул и ссылок. Заголовок аннотации, как пра-
вило, отсутствует.
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4.2 Окружения для создания списков

Стиль списка Название окружения

простой itemize

нумерованный enumerate

с длинными заголовками description

Каждый пункт списка начинается командой \item.
Изменить вертикальный интервал между элементами списка можно

с помощью параметра \itemsep.

4.1. Пример вёрстки простого списка.

• Первый элемент списка.

• Второй элемент списка.

Исходный TEX-код

\begin{itemize}

\item Первый элемент списка.

\item Второй элемент списка.

\end{itemize}

4.2. Пример вёрстки простого списка с модифицированными заго-
ловками и интервалом между элементами списка.

I. Первый элемент списка.

II. Второй элемент списка.

Исходный TEX-код

\begin{itemize}\itemsep=-1mm

\item[I.] Первый элемент списка.

\item[II.] Второй элемент списка.

\end{itemize}
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4.3. Пример вёрстки вложенных спиков.

• Первый элемент списка.

– Первый элемент вложенного списка.

– Второй элемент вложенного списка.

Исходный TEX-код

\begin{itemize}

\item Первый элемент списка.

\begin{itemize}

\item Первый элемент вложенного списка.

\item Второй элемент вложенного списка.

\end{itemize}

\end{itemize}

4.4. Пример вёрстки нумерованного списка.

1. Первый элемент списка.

2. Второй элемент списка.

3. Третий элемент списка.

Исходный TEX-код

\begin{enumerate}

\item Первый элемент списка.

\item Второй элемент списка.

\item Третий элемент списка.

\end{enumerate}
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4.5. Пример вёрстки списков description.

Название первого пункта. Первый элемент списка.

Название второго пункта. Второй элемент списка.

Название третьего пункта. Третий элемент списка.

Исходный TEX-код

\begin{description}

\item[Название первого пункта.] Первый элемент списка.

\item[Название второго пункта.] Второй элемент списка.

\item[Название третьего пункта.] Третий элемент списка.

\end{description}
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4.3 Окружение tabular

Окружение tabular позволяет создавать сложные таблицы с автома-
тическим определением ширины колонок, с рамками и без, с записями,
охватывающими несколько колонок.

WinEdt Команда меню: Insert → Tabular (n×m)

Формат окружения tabular
\begin{tabular}{преамбула_таблицы}

тело таблицы
\end{tabular}

преамбула_таблицы описывает структуру колонок таблицы. Структура,
в простейшем случае, задается буквами (по букве на каждую колонку):
l, r, c (см. табл. ниже), а также символами |, служащими для указания
вертикальных линеек, простирающихся на всю высоту колонки.

Тело текста представляет собой собственно текст таблицы, при этом
команда \\ разделяет строки таблицы, а знак &— колонки таблицы внутри
одной строки. Графа строки образует группу, так что изменение парамет-
ров шрифта в одной колонке не влияет на остальные. Ширина колонок
выбирается автоматически по максимальной ширине их содержимого.

Горизонтальные линейки, имеющие ширину таблицы, задаются коман-
дой \hline. Эта команда может стоять либо в начале таблицы, либо по-
сле команды \\. Для горизонтальных линеек, простирающихся от столбца
N до столбца M, используется команда \cline{N-M}.

Значения параметров в преамбуле окружения tabular

Параметр Тип выравнивания колонки
l по левому краю,
r по правому краю,
c с центрированным текстом.
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Исходный TEX-код

\begin{center}
\textbf{Значения параметров в преамбуле окружения
\texttt{tabular}}\\[3mm]
\begin{tabular}{c|l}

Параметр & Тип выравнивания колонки \\
\hline
\texttt{l} & по левому краю,\\[-0.5mm]
\texttt{r} & по правому краю, \\ [-0.5mm]
\texttt{c} & с центрированным текстом.

\end{tabular}
\end{center}

Для создания надписи, охватывающей несколько колонок, используется
команда \multicolumn:

\multicolumn{N}{преамбула_графы}{текст}

Аргументы команды multicolumn

N количество колонок, входящих в графу
преамбула_графы буквы l, r, c, возможно с символом |

текст текст графы

Исходный текст данной таблицы:

TEX-код
\begin{tabular}{|l|l|} \hline

\multicolumn{2}{|c|}{Аргументы команды \tt multicolumn} \\
\hline
\tt N & количество колонок, входящих в графу \\
\tt преамбула\_графы & буквы {\tt l}, {\tt r}, {\tt c},
возможно с символом \tt | \\
\tt текст & текст графы \\ \hline

\end{tabular}
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В случае, когда в строке таблицы необходимо разместить длинный
текст, занимающий абзац, для описания структуры колонки использует-
ся следующая преамбула

p{ширина колонки в TEX’овских единицах}

4.6. Пример вёрстки таблицы.

hhline пакет, позволяющий в LATEX 2ε облегчить работу с ли-
нованными таблицами.

Исходный TEX-код

\begin{tabular}{p{1,5cm}|p{12cm}}

\hline

\textsf{hhline} & пакет, позволяющий в \LaTeXe{} облегчить

работу с линованными таблицами.\\

\hline

\end{tabular}

4.2 (создание таблицы). Создайте таблицу вида

Логотипы и команды

TEX \TeX
LATEX \LaTeX
LATEX2ε \LaTeXe
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4.4 Титульный лист выпускной работы

Титульную страницу выпускной работы приходится создавать вруч-
ную, так как стандартных команд в LATEX’е, естественно, не предусмот-
рено. При создании титульной страницы следует учитывать, что

1) Нумерация страниц в выпускной работе начинается с титульной
страницы, однако на самой титульной странице номер 1 не указывается;

2) Существуют общепринятые заголовки выпускных работ:

3 курс Курсовая работа
4 курс Курсовая работа (или)

Выпускная квалификационная работа бакалавра
5 курс Дипломная работа
Магистратура Магистерская диссертация

3) Тема выпускной работы, написанная на титульном листе, должна
совпадать с темой, указанной в соответствующем приказе ВУЗа;

4) Научный руководитель каждого студента имеет некоторую долж-
ность и, как правило, научную степень (см. таблицы ниже). Информа-
ция о должности и ученой степени научного руководителя указывается
на титульной странице перед именем руководителя.

Должность Возможное сокращение

ассистент асс.
старший преподаватель ст. преп.
доцент доц.
профессор проф.
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Степень Возможное сокращение

кандидат физико-математических наук кандидат физ.-мат. наук;
канд. физ.-мат. наук;
к. ф.-м. н.

кандидат технических наук кандидат тех. наук;
канд. тех. наук;
к. т. н.

доктор физико-математических наук доктор физ.-мат. наук;
докт. физ.-мат. наук;
д. ф.-м. н.

доктор технических наук доктор тех. наук;
докт. тех. наук;
д. т. н.

Важно 1. В связи с постоянными изменениями требований, предъяв-
ляемых к оформлению как самих выпускных работ, так и титульных
листов, при окончательном оформлении выпускной работы необходи-
мо уточнить вид титульного листа на специализирующей кафедре.

4.3 (создание титульного листа). В проекте DiplomMain создайте но-
вый файл Titul.tex, в котором вручную создайте титульную страницу
выпускной работы (образцы см. на стр. 56, стр. 57, стр. 58 и стр. 59).

Указание 1. Для форматирования текста используйте разные типы вы-
равнивания текста по горизонтали и вертикальные пробелы «бесконеч-
ной» длины.

Указание 2. При использовании образцов со стр. 56 и стр. 57 для создания
информации о студенте и научном руководителе используйте таблицу
с тремя колонками.
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4.5 Автоматическая генерация ссылок

4. Информация о ссылках хранится в файле меток с расширением
aux (имя aux-файла совпадает с именем tex-файла).

Основные команды

\label{Метка_Объекта} — установка метки к любому фрагменту текста;
Метка_Объекта — набор символов (не используйте символы кириллицы),
регистр имеет значение;

\ref{Метка_Нумеруемого_Объекта} — ссылка на нумеруемый объект
в тексте (раздел, подраздел и т. п.); в тексте должна присутствовать мет-
ка с именем Метка_Нумеруемого_Объекта;

\pageref{Метка_Объекта} — ссылка на страницу, где находится метка;
в текста должна присутствовать метка с именем Метка_Объекта.

WinEdt Команды меню: Insert → LaTeX → Label,
Insert → LaTeX → Reference

4.4 (создание ссылки на страницу). Добавьте команду \label{Fio}

к своей фамилии на титульном листе. Где-нибудь в тексте (не на титуль-
ной странице) сделайте с помощью команды \pageref{Fio} ссылку на
свою фамилию, например, в виде

Автор этого труда (см.∼с.\, \pageref{Fio})
Дважды странслируйте текст и посмотрите результат.

4.5 (создание ссылки на страницу и раздел документа). Наберите текст

Тема «Подчеркивание,. . . » рассматривается в п. 1.2 на с. 41.

используя команды для создания автоматических ссылок на разделы
и страницы документа.
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4.6 Список литературы

Для оформления списка литературных источников используется ок-
ружение thebibliography

\begin{thebibliography}{text}

\bibitem{метка источника1}

Описание первого источника.

\bibitem{метка источника2}

Описание второго источника.

...

\end{thebibliography}

Здесь text — обязательный аргумент, указывающий максимально ши-
рокий текст метки. Например, заголовок \begin{thebibliography}{00}

предусматривает, что нумерация источников занимает не более, чем два
символа (взяты нули, как самые широкие цифры).

Каждый источник вводится командой \bibitem

\bibitem{метка источника}

метка источника — условное обозначение, состоящее из букв (заглавные
и прописные буквы различаются), цифр, знаков препинания и некоторых
других символов. Именно на эту метку можно оформить автоматические
ссылки с помощью команды \cite.

Заголовок списка литературы можно поменять, переопределив соот-
ветствующую команду (\refname — для класса article и \bibname — для
классов report и book). Например,

\renewcommand{\refname}{\centering {\bf Список литературы}}

Команда переопределения заголовка списка литературы указыва-
ется непосредственно перед окружением thebibliography.
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4.6 (список литературы). В конце текстового документа DiplomMain

(на новой странице) создайте список литературы в виде (обратите вни-
мание, что заголовок списка литературы отличается от стандартного):

Литература

[1] Гуссенс М., Миттельбах Ф., Самарин А. Путеводитель по пакету
LATEX и его расширению LATEX 2ε. М.: Мир, 1999.

[2] Жуков М. Ю., Ширяева Е. В. LATEX 2ε: искусство набора и вёрст-
ки текстов с формулами. Ростов н/Д : Изд-во ЮФУ, 2009.

[3] Кошкин M. М. Компьютерное моделирование супермышелов-
ки // Математическое моделирование. 2009. Т. 125, №13. С. 838–
848.

Ссылки на литературные источники в тексте

WinEdt Команда меню: Insert → LaTeX → Cite

4.7 (ссылки на литературные источники). Добавьте в свой документ
текст с автоматическими ссылками на литературные источники:

Хорошие книги по TEXу — [1, 2]. Интересная математическая модель
рассмотрена в работе [3, §§ 2–4].
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4.7 Создание оглавления

Команда для генерации оглавления

\tableofcontents

Компоненты оглавления формируются из нумеруемых разделов доку-
мента (\section, \subsection и т. п.).

Для добавления в оглавление ненумерумых заголовков (например, «Вве-
дение») используется команда \addcontentsline

\addcontentsline{toc}{тип раздела}{текст в оглавлении}

Здесь тип раздела — section, subsection и т. п. (более подробно о ко-
манде \addcontentsline см. например, в [2]).

4.8 (создание оглавления). Создайте в своем документе оглавление.
В нем обязательно должна присутствовать информация о списке лите-
ратуры и введении.
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4.8 Тесты

Раздел А «Выбор правильного ответа»

A1. Основные составляющие дипломной работы:

а) шапка, содержащая выходные данные; аннотация; основная часть;
список литературы

б) титульная страница; оглавление; основная часть; список литера-
туры

в) титульная страница; аннотация; основная часть

г) титульная страница; страница, содержащая выходные данные
и аннотацию; содержание/оглавление; основная часть; список ли-
тературы

A2. Команды секционирования

\part \chapter \section \subsection \subsubsection

\paragraph \subparagraph

а) определены во всех классах

б) определены только в классе book

в) определены только в классе report

г) определены только в классе article

A3. Выберите верный вариант использования команды секционирова-
ния:

а) \section[Полный заголовок]{Сокращенный заголовок}

б) \section[Сокращенный заголовок]{Полный заголовок}

в) \section[Полный заголовок]

г) \section
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A4. Для того, чтобы сделать автоматическую ссылку на страницу до-
кумента с некоторым фрагментом текста, соответствующее место
в тексте (содержащее данный фрагмент) должно быть отмечено
с помощью команды:

а) \ref б) \pageref в) \section г) \label

A5. Оглавление — это

а) перечень всех разделов, статей или отдельных произведений, по-
мещенных в издании, с указанием номеров страниц начала каждой
статьи

б) перечень всех входящих в издание частей, разделов, глав и пара-
графов с указанием номеров страниц, на которых они начинаются

в) перечень отдельных произведений, помещенных в издании, с ука-
занием номеров страниц начала каждой статьи

г) перечень всех входящих в издание частей, разделов, глав и пара-
графов

A6. Для автоматического формирования оглавления предназначена ко-
манда:

а) \setcounter{tocdepth}{toc}

б) \tableofcontents

в) \contents

г) \tocdepth{toc}

A7. Выберите правильный вариант использования команды
\addcontentsline:

а) \addcontentsline{toc}{\section*}{Заключение}

б) \addcontentsline{tex}{section}{Заключение}

в) \addcontentsline{toc}{\section}{Заключение}

г) \addcontentsline{toc}{section}{Заключение}
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A8. Обязательный параметр окружения thebibliography указывает:

а) максимальное число элементов библиографического списка

б) максимально широкий текст метки

в) минимальное число элементов библиографического списка

г) минимально широкий текст метки

A9. Для создания автоматической ссылки на библиографический источ-
ник с именем Test необходимо использовать команду:

а) \ref{Test} б) \bibitem{Test}

в) \cite{Test} г) \cite{test}

A10. Как будет выглядеть заголовок, задающий таблицу вида:

№ Как будет выглядеть заголо-
вок, задающий таблицу пред-
ставленного вида?

Тестирование

A11 1 балл

а) \begin{tabular}{rp{65mm}l}

б) \begin{tabular}{lp{65}r}

в) \begin{tabular}{lpr}

г) \begin{tabular}{lp{65mm}r}

A11. Выберите верное оформление затекстовой ссылки на книгу:

а) Название. Автор. Выходные данные.

б) Автор. Название. Выходные данные.

в) Название // Автор. Выходные данные.

г) Выходные данные // Автор. Название.
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Раздел B «Короткий ответ»

B1. Дан ошибочный tex-код для создания таблицы:
Ошибки набора

\begin{tabular}{lr}

Тип & параметров окружения для создания таблицы

\hline

Параметр \verb"|" & задает вертикальную линейку\\

Параметр \verb"c" & задает центрирование текста

в колонке

\hline

\end{tabular}

Исправьте ошибки, чтобы получить таблицу в виде:

Тип параметров окружения для создания таблицы
Параметр | задает вертикальную линейку
Параметр c задает центрирование текста в колонке

B2. Запишите tex-код для создания таблицы:

М И Р
М И Р
М И Р
М И Р

B3. Запишите tex-код для создания таблицы:

Научная классификация

Царство: Животные Семейство: Хомяковые
Тип: Хордовые Подсемейство: Хомяки

Отряд: Грызуны Вид: Джунгарский хомячок
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B4. Запишите tex-код для создания таблицы:

№ ФИО «?»

1. Иванов И.И. отчислить
2. Петров П.П. не отчислять
2
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Раздел C «ПрактикаF»

С1. Создайте текстовый документ в виде:

1-ая страница: пустая

2-ая страница: содержание

3-я страница: сверху страницы — список литературы, состоящий из
двух источников (книги и статьи)

4-ая страница: внизу страницы — текст со ссылкой на литературу
(на страницу, где расположена литература) и на оба библиографи-
ческих источника из списка литературы

5 страница: пустая

С2. Запишите tex-код для создания таблицы:

§ ¶ %
c© U r

£ z X

Для выполнения задания подключите пакет amssymb.
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Открыть тест с возможностью самопроверки
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4.9 Индивидуальные проекты

1. Разработайте и создайте шаблон статьи, удовлетворяющий некото-
рым требованиям: левое поле, высота текста, ширина текста — по
усмотрению автора шаблона (но не стандартные).

Предполагается, что статья должна содержать

а) индекс УДК;

б) название статьи;

в) ФИО авторов;

г) название организации;

д) аннотацию;

е) тело документа без использования команд секционирования;

ж) список литературы.

2. Разработайте и создайте шаблон курса лекций, удовлетворяющий
некоторым требованиям: левое поле, высота текста, ширина тек-
ста — по усмотрению автора шаблона (но не стандартные).

Предполагается, что текстовый документ должен содержать

а) титульную страницу с указанием названий учебного заведения
и дисциплины, ФИО лектора и года чтения лекций;

б) оглавление;

в) аннотацию;

г) тело документа с использованием команд секционирования;

д) список литературы.
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Проектные задания
Задание № 1
Задание № 2
Задание № 3
Задание № 4
Задание № 5
Задание № 6
Задание № 7

Проектные задания

Создать минимальный файл LATEX 2ε для вывода текста задания.

Задание 1 «Команда plot3d (пакет Maple)» с. 73
Задание 2 «Команда plot (пакет Maple)» с. 76
Задание 3 «Команда plot (пакет FreeFem++)» с. 78
Задание 4 «Типы конечных элементов (пакет FreeFem++)» с. 79
Задание 5 «Фелинология» с. 81
Задание 6 «Джунгарский хомячок» с. 83
Задание 7 «Хомяки» с. 85

Составляющие текстового документа по заданиям
Номер задания

Составляющие документа № 1 № 2 № 3 № 4 № 5 № 6 № 7
Титул XXX XXX XXX XXX XXX XXX XXX

Аннотация XXX XXX XXX XXX XXX XXX

Разделы документа XXX XXX XXX XXX XXX XXX XXX

Подразделы документа XXX XXX XXX XXX

Таблица XXX XXX XXX XXX XXX XXX

Список XXX XXX

Список литературы XXX XXX XXX XXX XXX XXX XXX

Ссылки на разделы документа XXX XXX XXX

Ссылки на литературу XXX XXX XXX XXX XXX XXX XXX
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Задание № 1

Темы задания:

1. Создание TEX-файла, содержащего минимальный набор команд.

2. Корректный набор текста (см. Некоторые важные правила набора
текстов, Разные знаки в тексте и т. п.).

3. Использование различных шрифтов.

4. Использование «буквального воспроизведения текста».

5. Абзацы с нестандартным форматированием.

6. Создание шапки документа стандартными средствами LATEX 2ε.

7. Создание автоматически нумеруемых разделов документа.

8. Создание автоматически нумеруемых подразделов документа.

9. Создание таблиц.

10. Создание списка литературы стандартными средствами LATEX2ε.

11. Создание автоматических ссылок на нумеруемые разделы документа.

12. Создание автоматических ссылок на библиографические источники
из списка литературы.
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Команда plot3d (пакет Maple)

П ет р о в И. И.

Ростов-на-Дону, 2015–2016 уч. год

1 Графика в Maple — элементарное введение

1.1 Команда plot3d

Команда, позволяющая строить графики функции двух переменных

plot3d(expr, x = a..b, y = c..d, opts)

здесь expr — выражение, зависящие от двух переменных;
<opts> — опции, меняющие свойства графика (см. раздел 1.2).

Графические команды подробно рассмотрены в работе [1, §§ 13–15].

1.2 Параметры команды plot3d

Некоторые опции команды plot3d

title = "Name" заголовок рисунка
shading = название схемы схема закрашивания поверхности

(xyz, xy, z, zgrayscale, zhue, none)

Список использованной литературы

[1] Говорухин В.Н., Цибулин В. Г. Компьютер в математическом иссле-
довании. Учебный курс. СПб.: Питер, 2001.

[2] Жуков М. Ю., Ширяева Е. В. LATEX 2ε: искусство набора и вёрстки
текстов с формулами. Ростов н/Д : Изд-во ЮФУ, 2009.

[3] Мышкин M. М. Имитационное моделирование антимышеловки //
Математическое моделирование. 2014. Т. 127, №5. С. 38–47.
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Темы задания:

1. Создание TEX-файла, содержащего минимальный набор команд.

2. Корректный набор текста (см. Некоторые важные правила набора
текстов, Разные знаки в тексте и т. п.).

3. Использование различных шрифтов.

4. Использование «буквального воспроизведения текста».

5. Абзацы с нестандартным форматированием.

6. Создание шапки документа стандартными средствами LATEX 2ε.

7. Создание аннотации стандартными средствами LATEX 2ε.

8. Создание автоматически нумеруемых разделов документа.

9. Создание автоматически нумеруемых подразделов документа.

10. Создание таблиц.

11. Создание списка литературы стандартными средствами LATEX 2ε.

12. Создание автоматических ссылок на библиографические источники
из списка литературы.
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Задание № 2

Команда plot (пакет Maple)

Кошкин И.И.

ЮФУ, Ростов-на-Дону, 2015–2016 уч. год

В пакете Maple имеется большое количество команд для работы с дву-
мерной и трехмерной графикой. Далее рассмотрена простейшая коман-
да для построения графика функции одной переменной.

1 Графика в Maple — элементарное введение

Графические команды подробно рассмотрены в работе [1, §§ 3–5].

1.1 Команда plot

Команда, позволяющая строить графики функций одной переменной

plot({F1, F2, ...}, x = a..b, y = c..d, <options>)

здесь F1, F2,. . . — выражения, зависящие от одной переменной;
<options> — опции, меняющие свойства графика.

1.2 Параметры команды plot

Некоторые опции двумерной графики

title = "Name" заголовок рисунка
style = line/point стиль вывода графика — линиями или точками
thickness = n толщина линии

Список литературы

[1] Говорухин В.Н., Цибулин В. Г. Компьютер в математическом исследова-
нии. Учебный курс. — СПб.: Питер, 2001.

[2] Жуков М.Ю., Ширяева Е.В. LATEX 2ε: искусство набора и вёрстки текстов
с формулами. — Ростов н/Д : Изд-во ЮФУ, 2009.

[3] Кошкин M.М. Компьютерное моделирование супермышеловки // Математи-
ческое моделирование. — 2009. — Т. 125, №13. — С. 838–848.
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Темы задания:

1. Создание TEX-файла, содержащего минимальный набор команд.

2. Корректный набор текста (см. Некоторые важные правила набора
текстов, Разные знаки в тексте и т. п.).

3. Использование различных шрифтов.

4. Использование «буквального воспроизведения текста».

5. Абзацы с нестандартным форматированием.

6. Создание шапки документа стандартными средствами LATEX 2ε.

7. Создание аннотации стандартными средствами LATEX 2ε.

8. Создание автоматически нумеруемых разделов документа.

9. Создание автоматически нумеруемых подразделов документа.

10. Создание таблиц.

11. Создание списка литературы стандартными средствами LATEX 2ε.

12. Создание автоматических ссылок на библиографические источники
из списка литературы.
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Задание № 3

Команда plot (пакет FreeFem++)
Иванов И.И.

ЮФУ, Ростов-на-Дону

Пакет FreeFem++ предназначен для численного решения дифференциаль-
ных уравнений в частных производных методом конечных элементов.

1 Визуализация результатов расчетов

Визуализация результатов расчетов на экране в виде сеток, изоли-
ний конечно-элементных функций и векторных полей возможна с помо-
щью команды plot. Подробно о команде plot см., например, в [1, § 21,
стр. 238–245].

1.1 Синтаксис команды plot

plot(u, <options>),

здесь u — выражение, зависящее от двух переменных; <options> — спи-
сок опций, влияющих на вид изображения.

1.2 Параметры команды plot

Некоторые опции команды plot

fill = B заливка области между изолиниями (0 — нет заливки)
wait = 1 пауза в выполнении программы
ps = "Name" сохранение рисунка в postscript-файл с именем Name

Список литературы

[1] Жуков М.Ю., Ширяева Е.В. Использование пакета конечных элементов
FreeFem++ для задач гидродинамики, электрофореза и биологии. — Ростов
н/Д : Изд-во ЮФУ, 2008.

[2] Жуков М.Ю., Ширяева Е.В. LATEX 2ε: искусство набора и вёрстки текстов
с формулами. — Ростов н/Д : Изд-во ЮФУ, 2009.
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Задание № 4

Темы задания:

1. Создание TEX-файла, содержащего минимальный набор команд.

2. Корректный набор текста (см. Некоторые важные правила набора
текстов, Разные знаки в тексте и т. п.).

3. Использование различных шрифтов.

4. Абзацы с нестандартным форматированием.

5. Создание шапки документа стандартными средствами LATEX 2ε.

6. Создание аннотации стандартными средствами LATEX 2ε.

7. Создание автоматически нумеруемых разделов документа.

8. Создание автоматически нумеруемых подразделов документа.

9. Создание таблиц.

10. Создание списков.

11. Создание списка литературы стандартными средствами LATEX 2ε.

12. Создание автоматических ссылок на библиографические источники
из списка литературы.
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Типы конечных элементов (пакет FreeFem++)
Иванов И.И.

ЮФУ, Ростов-на-Дону

Пакет FreeFem++ предназначен для численного решения дифференциаль-
ных уравнений в частных производных методом конечных элементов.

1 Конечные элементы

Термин конечный элемент означает носитель базисной функции.
Часто и сами базисные функции также называют конечными элемента-
ми. Например, такая терминология принята в пакете FreeFem++ (см. [1,
стр. 209]).

1.1 Типы конечных элементов пакета FreeFem++

• Стандартные

– P0

– P1, P1b, P1dc

– P2, P2b, P2dc

• Загружаемые

– P3, P3dc

– P4, P4dc

– P2BR

Описание отдельных конечных элементов
P0 кусочно-постоянные разрывные КЭ
P1 кусочно-линейные непрерывные КЭ
P2 кусочно-квадратичные непрерывные КЭ

Список использованной литературы

[1] Жуков М.Ю., Ширяева Е.В. Использование пакета конечных элементов
FreeFem++ для задач гидродинамики, электрофореза и биологии. — Ростов
н/Д : Изд-во ЮФУ, 2008.

[2] Жуков М.Ю., Ширяева Е.В. LATEX 2ε: искусство набора и вёрстки текстов
с формулами. — Ростов н/Д : Изд-во ЮФУ, 2009.
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Задание № 5

Темы задания:

1. Создание TEX-файла, содержащего минимальный набор команд.

2. Корректный набор текста (см. Некоторые важные правила набора
текстов, Разные знаки в тексте и т. п.).

3. Использование различных шрифтов.

4. Абзацы с нестандартным форматированием.

5. Создание шапки документа стандартными средствами LATEX 2ε.

6. Создание аннотации стандартными средствами LATEX 2ε.

7. Создание автоматически нумеруемых разделов документа.

8. Создание таблиц.

9. Создание списка литературы стандартными средствами LATEX2ε.

10. Создание автоматических ссылок на библиографические источники
из списка литературы.
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Фелинология

Мышкин М.М. (ЮФУ, Ростов-на-Дону)

Фелинология (от лат. felinus — кошачий и др.-греч. λoγoζ — слово, уче-
ние) — раздел зоологии, изучающий анатомию и физиологию домашних ко-
шек, а также их породы, особенности их селекции и содержания [1].

1 Определение предмета изучения

Кошка (лат. Félis silvéstris cátus) — домашнее животное, одно из наи-
более популярных «животных-компаньонов» (см. [1]). Кошка — социаль-
ное животное [2, с. 19–28], использующее для общения широкий диапазон
звуковых сигналов, а также феромоны и движения тела.

2 Фелинологические организации

Фелинологические организации составляют списки пород кошек, про-
водят международные выставки и занимаются выведением новых пород.

Основные фелинологические организации
FIFe Международная федерация кошек
CFA Ассоциация любителей кошек
ICU International Cat Union
TICA Международная кошачья ассоциация
WCF Всемирная федерация кошек
МФА Международная Фелинологическая Ассоциация
WACC World Association of Cat Clubs

Список использованной литературы

[1] Фелинология // Википедия [Электронный ресурс]. ru.wikipedia.org/wiki (да-
та обращения: 13.04.2014).

[2] Crowell-Davis S., Curtis T., Knowles R. Social organization in the cat: a modern
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мулами. Ростов н/Д : Изд-во ЮФУ, 2009.
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Задание № 6

Темы задания:

1. Создание TEX-файла, содержащего минимальный набор команд.

2. Корректный набор текста (см. Некоторые важные правила набора
текстов, Разные знаки в тексте и т. п.).

3. Использование различных шрифтов.

4. Абзацы с нестандартным форматированием.

5. Создание шапки документа стандартными средствами LATEX 2ε.

6. Создание аннотации стандартными средствами LATEX 2ε.

7. Создание автоматически нумеруемых разделов документа.

8. Создание таблиц.

9. Создание списка литературы стандартными средствами LATEX2ε.

10. Создание автоматических ссылок на нумеруемые разделы документа.

11. Создание автоматических ссылок на библиографические источники
из списка литературы.
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Джунгарский хомячок

Мышкин М.М.
(ЮФУ, Ростов-на-Дону)

Хомяки (лат. Cricetinae) — небольшое (19 видов) подсемейство грызунов
семейства хомяковых. Научная классификация представлена в разделе 2.

1 Определение предмета изучения

Джунга́рский хомячо́к (лат. Phodopus sungorus) — вид рода мохноно-
гих хомячков. Популярное домашнее животное (см. [1, 2]). Распростра-
нён по сухим степям и полупустыням юга Западной Сибири, Восточного
Казахстана, в Хакасии.

Рост до 5 см, вес до 45 граммов. Данный вид грызунов имеет покры-
тые волосами ступни, тёмную полосу на спине (обычно серая), очень
короткий хвост. Мех отличается значительными белыми вкраплениями.

2 Научная классификация

Научная классификация
Царство: Животные Семейство: Хомяковые

Тип: Хордовые Подсемейство: Хомяки
Класс: Млекопитающие Род: Мохноногие хомячки
Отряд: Грызуны Вид: Джунгарский хомячок

Список использованной литературы

[1] Хомяк // Википедия [Электронный ресурс]. ru.wikipedia.org/wiki
(дата обращения: 13.04.2014).
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и Ефрона: В 86 томах (82 т. и 4 доп.). СПб., 1890–1907.

[3] Жуков М.Ю., Ширяева Е. В. LATEX 2ε: искусство набора и вёрстки
текстов с формулами. Ростов н/Д : Изд-во ЮФУ, 2009.
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Задание № 7

Темы задания:

1. Создание TEX-файла, содержащего минимальный набор команд.

2. Корректный набор текста (см. Некоторые важные правила набора
текстов, Разные знаки в тексте и т. п.).

3. Использование различных шрифтов.

4. Создание шапки документа стандартными средствами LATEX 2ε.

5. Создание аннотации стандартными средствами LATEX 2ε.

6. Создание автоматически нумеруемых разделов документа.

7. Создание списков.

8. Создание списка литературы стандартными средствами LATEX2ε.

9. Создание автоматических ссылок на нумеруемые разделы документа.

10. Создание автоматических ссылок на библиографические источники
из списка литературы.
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Хомяки

Кот о в К.К.
ЮФУ, Ростов-на-Дону

Хомяки́ (лат. Cricetinae) — подсемейство грызунов семейства хомяко-
вых [1]. Классификация представлена в разделе 2.

1 Общий облик

К семейству хомяков относятся небольшие, плотно сложенные гры-
зуны с короткими конечностями, маленькими ушами и короткими хво-
стами. Длина тела: 5–34 см, хвоста: 0.7–10 см. Окраска густого меха на
спине от пепельно- или буровато-серой до тёмной коричнево-охристой;
на животе — чёрная, белая или серая. Иногда вдоль спины проходит
чёрная полоса. Имеются очень развитые защёчные мешки [2].

2 Классификация

Небольшое подсемейство Cricetinae включает 19 видов, относящихся
к семи родам:

• Род Средние хомяки (Mesocricetus)

– Сирийский хомячок,
– Хомяк Брандта,
– Хомяк Радде,
– Хомяк Ньютона

• Род Мохноногие хомячки (Phodopus)

– Джунгарский хомячок,
– Хомячок Кэмпбелла,
– Хомячок Роборовского

• Род Cricetus

– Обыкновенный хомяк
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• Род Серые хомячки (Cricetulus)

– Короткохвостый хомячок,
– Барабинский хомячок,
– Тибетский хомячок,
– Длиннохвостый хомячок,
– Серый хомячок,
– Хомячок Соколова

• Род Эверсмановы хомячки (Allocricetulus)

– Монгольский хомячок,
– Хомячок Эверсмана

• Род Cansumys

– Канский хомяк

• Род Tscherskia

– Крысовидный хомячок

Список литературы
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Спецсимволы

\ начало команды или параметра

{ } начало и конец группы

% комментарий

~ неразрывный пробел

# обозначение аргумента в команде

$ начало/конец формулы

& табуляция

_ начало нижнего индекса

^ начало верхнего индекса



Типы файлов

Расширение файла Пояснение Стр.

.aux файл меток 60

.cls файл класса 14

.dvi выходной файл TEX’а 13

.lof файл списка иллюстраций

.log файл протокола работы TEX’а 15

.lot файл списка таблиц

.sty файл пакета 14

.tex входной файл TEX’а 13

.toc файл оглавления 63

.eps файл Encapsulated PostScript 6

.ps файл PostScript 6

.pdf файл Portable Document Format 6

.tpx файл программы TpX 11



Глоссарий

B
BibTEX — программное обеспечение для создания форматированных
списков библиографии. BibTEX используется совместно с LATEX’ом и
входит в дистрибутив MikTeX.

D
DjVu (AT&T Research) — технология сжатия изображений с потерями,
разработанная специально для хранения сканированных документов.

DjVu-файл может содержать

• текстовый (OCR) слой, что позволяет осуществлять полнотексто-
вый поиск по файлу;

• встроенное интерактивное оглавление и ссылки для навигации.

DVI (англ. DeVice Independent — аппаратно независимый) — формат
выходных файлов системы TEX. Файлы DVI содержат двоичные данные
для описания визуального представления документа. Способ описания не
ориентирован на какой-либо формат изображения, монитор или принтер.
Программа для просмотра DVI-файлов: Yap.

E
Encapsulated PostScript—PostScript-программа, сохраненная как оди-
ночный файл с эскизом (preview). Не может содержать в одном файле
более одной страницы, не сохраняет ряд установок для принтера.

Environments — см. окружение.
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EPS-файл содержит в BoundingBox DSC comment информацию, опи-
сывающую размер изображения. Если приложение не может растеризо-
вать данные, содержащиеся в EPS-файле, оно имеет доступ к размерам
изображения и его preview. Бесплатные программы для просмотра EPS-
файлов: GIMP, GSview, Sumatra PDF.

G
Ghostscript — программный интерпретатор языка PostScript.

GSVeiw — программа, позволяющая просматривать, конвертировать и
печатать файлы в форматах PS, EPS и PDF.

L
LATEX 2ε — система для набора и вёрстки текстов с формулами. Наибо-
лее популярный макропакет системы TEX.

M
MiKTeX — дистрибутив (open source) TEX для платформы Windows;
содержит полный набор макропакетов.
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P
PDF (Portable Document Format) (Adobe Systems) — формат фай-
лов, содержащий информацию по описанию страницы, а также — шриф-
ты, изображения, команды печати, ключевые слова для поиска и ин-
дексации файла, звук, видео, гипертекстовые ссылки и т. д. Внутренняя
структура PDF-файла является целиком объектной.

PostScript (Adobe Systems) — язык программирования, который опи-
сывает страницу (как она будет выглядеть).

PS — расширение файлов PostScript. PS и EPS файлы можно легко кон-
вертировать в PDF. Программы для просмотра PS-файлов см. в описа-
нии EPS-файлов.

S
Sumatra PDF — свободная программа, предназначенная для просмотра
и печати документов в форматах PDF, DjVu, FB2, CHM, Postscript для
платформы Windows. Sumatra поддерживает SyncTeX.

SyncTeX — двусторонний метод синхронизации исходных текстов TEX

и выходных PDF, полученных с помощью pdfTeX или XeTEX.

T
TEX — система для набора и вёрстки текстов с формулами.

TEXnicCenter — бесплатная оболочка для работы с TEX’ом.
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TpX — редактор (open source) векторной графики, ориентированный на
работу с системой TEX (tpx.sourceforge.net).

U
Unicode — универсальная система кодирования символов. Позволяет
представить знаки почти всех письменных языков мира. Содержит на-
бор графических символов и способ их кодирования для компьютерной
обработки текстовых данных.

W
WinEdt — платная специализированная оболочка для работы с TEX’ом
(ОС Windows). Используется для редактирования документов HTML и
других текстовых файлов.

WYSIWYG (What You See Is What You Get; что видите, то и полу-
чите) — свойство прикладных программ, в которых содержание отоб-
ражается в процессе редактирования и выглядит максимально близко
похожим на конечную продукцию.

X
XeTeX (произносится как «зи-тех») — система вёрстки, базирующая-
ся на TEX’е. Использует Unicode. Может использовать любые шрифты,
установленные в данной ОС без настройки шрифтов TEX.
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Y
Yap (Yet Another Previewer) — средство просмотра dvi-файлов.

В
Векторизация — процесс перевода из растровой графики в векторную
(обратный процессу растеризации).

Г
Группа — фрагмент TEX-файла, заключенный в фигурные скобки.

Е

Единицы длины Величина интервала

mm миллиметр
cm сантиметр = 10 mm
pt пункт ≈ 0,35 mm
in дюйм = 25,4 mm
dd пункт Дидо ≈ 1,07 pt
em ≈ ширине буквы M текущего шрифта
ex ≈ высоте буквы x текущего шрифта

К
Кегль — размер шрифта, т. е. высота буквы с над- и подстрочными эле-
ментами (заплечиками). Выражается в пунктах.

М
Макропакет (в TEX’е) — набор макрокоманд, написанных на языке
TEX.
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Макрос (макрокоманда) — объект, который при обработке заменяет-
ся последовательностью программных инструкций.

О
Окружение (Environments) — фрагмент TEX-файла, ограниченный ко-
мандными скобками

\begin{ИмяОкружения}
...

\end{ИмяОкружения}

П
Пакет — набор команд, не специфичных для данного класса.

Пункт — единица длины, равная 0,376мм (в TEX’е это пункт Дидо).

Пункт в TEX’e — единица длины, равная 0,35мм (англо-американский
пункт).

Р
Растеризация — перевод двумерного изображения, описанного вектор-
ным форматом, в пиксели или точки для вывода на дисплей или принтер.
Процесс, обратный векторизации.

Ш
Шрифт typewriter — моноширинный (непропорциональный) шрифт,
имитирующий шрифт пишущей машинки (наиболее известные моноши-
ринные шрифты Courier и Courier New).
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